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General Information

Hazardous Information Messages
 CAUTION

Cautions indicate potentially hazardous situations, which can result in 
personal injury or equipment damage if not avoided. 

 WARNING
Warnings indicate potentially hazardous situations, which can result in 
property damage, severe personal injury, or death if not avoided. 

 DANGER
Dangers indicate a hazardous electrical situation which will result in death 
or serious injury if not avoided.

 NOTICE
Notices give important information concerning a process, procedure, 
special handling or equipment attributes.

NOTE:	 Indicates important details or clarifying statements for 
information presented.

Notice 
© 2021 Daikin Applied, Minneapolis MN. All rights reserved 
throughout the world
Daikin Applied reserves the right to change any information 
contained herein without prior notice. The user is responsible 
for determining whether this product is appropriate for his or 
her application.

® ™ The following are trademarks or registered trademarks 
of their respective companies: Flasher, JFlash ARM, J-Link, 
Renesas from Renesas Electronics Corporation, Segger 
from Segger Microcontroller Systems LLC; Atmel from Atmel 
Microprocessor, Inc., Smart ARM Microcontroller (SAM-BA) 
from Atmel, Windows from Microsoft Corporation; BACnet from 
ASHRAE; Visio from Microsoft Corporation; LonWorks and 
LonMaker from Echelon Corporation, MicroTech from Daikin 
Applied.

Reference Documents
Number Company Title Source

OM 931

Daikin Applied

MicroTech III Water Source 
Heat Pump Enfinity Single 
Stage Compressor Unit 
Controller Operation and 
Maintenance Manual

www.
DaikinApplied.

com

OM 1149

MicroTech III Water Source 
Heat Pump SmartSource 
Single & Two Stage 
Compressor (Series2) Unit 
Controller Operation and 
Maintenance Manual

OM 1239 

MicroTech III Water Source 
Heat Pump Enfinity Large 
Two Compressor (SS2C) 
Unit Controller Operation and 
Maintenance Manual

OM 1254 Daikin Applied System 
Manager Operation Manual

IM 927
MicroTech III Water Source 
Heat Pump LonWorks 
Communication Module 
Installation Manual

IM 928
MicroTech III Water Source 
Heat Pump BACnet 
Communication Module 
Installation Manual

ED 15103
MicroTech III Water Source 
Heat Pump Unit Controller 
Protocol Information Manual
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Introduction 

 DANGER
Electric shock hazard. Can cause personal injury or equipment damage.
This equipment must be properly grounded. Only personnel who are 
knowledgeable in the operation of the equipment being controlled must 
perform connections and service to the unit controller.

 CAUTION
Static sensitive components. Can cause equipment damage.
Discharge any static electrical charge by touching the bare metal inside the 
control panel before performing any service work. Never unplug cables or 
control modules while power is applied to the unit controller.

 NOTICE
This equipment generates; uses and can radiate radio frequency energy 
and, if not installed and used in accordance with this instruction manual, 
may cause interference to radio communications. It has been tested and 
found to comply with the limits for a Class A digital device, pursuant to 
part 15 of the FCC rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated 
in a commercial environment. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his or her own expense. Daikin 
Applied disclaims any liability resulting from any interference or for 
the correction thereof.

Introduction
The purpose of this document is to describe how to download 
MicroTech® III water source heat pump (WSHP) unit controller, 
I/O expansion module, and network communication software. It 
also explains what programming tools are needed to install and 
verify that the correct software has been installed correctly.

It is assumed that the unit controller and optional modules have 
been installed and are functioning properly. If necessary, refer 
to the Reference Documents section for installation manual 
details.

This guide is organized into four main sections:

1.	 WSHP Unit Controller and I/O Expansion Module
2.	 BACnet Communication Module
3.	 LonWorks Communication Module
4.	 Troubleshooting Guide and FAQ

The Troubleshooting section is a helpful reference with tips on 
solving potential hardware and/or software issues, along with 
detailed descriptions of WSHP unit options by model number 
and associated equipment configuration hardware jumper 
settings.

Terminology
•	 MicroTech III Unit Controller. The baseboard attached to 

the WHSP which is downloaded with the most current 
version of application software for unit operation. The 
terms MicroTech III or MTIII are also used to reference 
the I/O expansion module and communication modules in 
addition to the baseboard.

•	 I/O Expansion Module: Optional daughter board that 
provides additional input/output capability for secondary 
compressor, multiple speed fan, secondary heating, and 
dehumidification control. The I/O expansion module is 
attached directly to unit controller when these options 
have been selected with the unit.

•	 Custom Interface Cables: Two different cable kit 
assemblies have been designed by Daikin for use with 
the programming tools needed to download software to 
the baseboard part number 668105611 or I/O expansion 
module part number 668105711. One cable assembly 
supports the Renesas E2 Lite/E1 programmer. A separate 
(but similar) cable assembly supports the Renesas E8a 
programmer. Each custom cable assembly includes a 
small PCB with 14-pin port for connection to the Renesas 
programmer and either a 6-pin or 10-pin port (depending 
on WSHP controller hardware version) for connection to 
the baseboard or I/O expansion module.

•	 JTAG: The hardware interface required for downloading 
older versions of unit controller and I/O expansion 
module software. JTAG refers to both the connector port 
attached to the unit controller as well as the cable used 
to download software to the BACnet communication 
module. 

•	 Renesas Flash Programmer (RFP) Tools: The 
software used with the Renesas E2-Lite or E1 hardware 
to program the current RL78/G13 family of Renesas 
microcontrollers. The RFP tools support the R5F101FE 
MCU used on WSHPs with hardware PNs 668105611 
and 668105711.

•	 .rpj File: The project file type used used to specify the 
RFP software configuration settings.

•	 Renesas Flash Development Toolkit (FDT): The 
software used with the Renesas E8a hardware 
to program the obsolete 740 family of Renesas 
microcontrollers. The FDT supports the M38507F8A MCU 
used on WSHPs with hardware PNs 668105601 and 
668105702.

•	 Segger Flasher Tools (Obsolete): The software used 
with the Segger Flasher5 hardware to program the 740 
family of legacy Renesas microcontrollers. Flasher5 
supports the M38507F8A MCU used on WSHPs with 
hardware PNs 668105601 and 668105702.

•	 Segger J-Link / Atmel SAMBA Tools: The software 
used with the Segger J-Link / Atmel SAM-ICE hardware 
to program the BACnet communication module 
microcontroller used on FCU/WSHP hardware PN 
668105901.

•	 .hex File: The unit controller baseboard or I/O expansion 
module software file. A separate .hex file is required for 
each board.

•	 .mot File: The unit controller baseboard or I/O expansion 
module software file. A separate .mot file is required for 
each board.

•	 .bin File: The BACnet communication module firmware.
•	 .nxe File: The LonWorks communication module 

firmware.
•	 U-10: The network inteface hardware used for LonWorks 

communication module software downloading.
•	 MCU: Refers to the microcontroller unit chip. It uses 

embedded Flash memory to store and execute the 
application.

http://www.DaikinApplied.com
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MicroTech III WSHP Software Compatibility
There are four types of WSHP models. Each has software 
specific to that model and unit controller hardware part number. 
See Table 1-Table 4 for compatibility among the unit models, 
hardware part numbers, and software versions. Figure 1 

(Enfinity) and Figure 2 (SmartSource) show the software label 
as it is applied on two different vintages of the unit controller. 
This label indicates the version of factory-installed code.  

Table 1: Software Compatibility – Enfinity® Single Speed Compressor Models     
WSHP Unit Controller

Models MHC/MHW, CCH/CCW (5-Ton or Less), VFC/VFW, LVC/LVW, VHC/VHF
Baseboard 

Software: 2506900 
Hardware: 668105601

Baseboard  
Software: 2508085 

Hardware: 668105611
Auxiliary 

Board Part Number Version v2.5 v2.6 v2.7 v2.8 v2.9 v3.0 v3.1 v3.2 v1.1

I/O 
Expansion 

Module

Software: 2506901 
Hardware: 668105702

v2.4 Yes No No No No No No No No
v2.6 No Yes Yes Yes Yes Yes Yes Yes Yes
v2.8 No Yes Yes Yes Yes Yes Yes Yes Yes
v3.0 No Yes Yes Yes Yes Yes Yes Yes Yes

Software: 2508086 
Hardware: 668105711 v1.0 No Yes Yes Yes Yes Yes Yes Yes Yes

BACnet 
Module

Software: 2506903 
Hardware: 668105901

v2.51 Yes Yes Yes Yes Yes Yes Yes4 Yes4 Yes4

v2.71 Yes Yes Yes Yes Yes Yes Yes4 Yes4 Yes4

v2.81 Yes Yes Yes Yes Yes Yes Yes4 Yes4 Yes4

v3.01 Yes3 Yes3 Yes3 Yes3 Yes3 Yes Yes4 Yes4 Yes4

v3.11 Yes3 Yes3 Yes3 Yes3 Yes3 Yes Yes Yes Yes
v3.21 Yes3 Yes3 Yes3 Yes3 Yes3 Yes Yes Yes Yes
v3.31 Yes3 Yes3 Yes3 Yes3 Yes3 Yes Yes Yes Yes
v3.4 Yes3 Yes3 Yes3 Yes3 Yes3 Yes Yes Yes Yes

LonWorks 
Module

Software: 2506902 
Hardware: 668105801

v2.52 Yes Yes Yes Yes Yes Yes Yes4 Yes4 Yes4

v2.72 Yes Yes Yes Yes Yes Yes Yes4 Yes4 Yes4

v2.82 Yes Yes Yes Yes Yes Yes Yes4 Yes4 Yes4

v3.02 Yes Yes Yes Yes Yes Yes Yes4 Yes4 Yes4

v3.1 Yes Yes Yes Yes Yes Yes Yes Yes Yes
1. BACnet software v3.4 or greater is recommended for optimal network communications performance.
2. LonWorks software v3.1 or greater is recommended for optimal network communications performance.
3. WSHP unit controller and BACnet software versions are fully compatible. Note that the heat pump number (HP), which is visible at the top of the BACnet 

Configuration Menu, from the BAS, or other BACnet application, may appear as an invalid number between 0 and 255 when the BACnet software version is newer 
than the unit controller software version. Although visible, the HP number shown does not impact the unit or network communication performance.

4. Low Entering Water Temperature (EWT) alarm is not supported by the communication module.

Table 2: Software Compatibility – SmartSource® Single and Two Speed Compressor (Series2) Models
WSHP Unit Controller 

Models GSH/GSV, GTH/GTV, GCV
Baseboard  

Software: 2508060
Hardware: 668105601 

Baseboard 
Software: 2508078  

Hardware: 668105611
Auxiliary Board Part Number Version v5.0 v6.0 v6.1 v6.2 v1.1

I/O Expansion 
Module  

Software: 2508061 
Hardware:668105702

v5.0 Yes Yes2 Yes2 Yes2,3 Yes2,3

v6.0 Yes Yes Yes Yes3 Yes3

v6.1 Yes Yes Yes Yes3 Yes3

v6.2 Yes Yes Yes Yes Yes

Software: 2508079 
Hardware: 668105711

v1.05 Yes Yes Yes Yes Yes
v7.0 Yes Yes Yes Yes Yes

BACnet Module Software: 2508062 
Hardware: 668105901

v5.01 Yes Yes Yes Yes Yes
v6.01 Yes Yes Yes Yes Yes
v6.11 Yes Yes Yes Yes Yes
v6.21 Yes Yes Yes Yes Yes
v6.31 Yes Yes Yes Yes Yes
v6.4 Yes Yes Yes Yes Yes

LonWorks Module Software: 2508063 
Hardware: 668105801

v5.04 Yes Yes Yes Yes Yes
v6.0 Yes Yes Yes Yes Yes

1. BACnet software v6.4 or greater is recommended for optimal network communication performance.
2. The I/O expansion module does not support Hydronic Heating.
3. The I/O expansion module does not support Hydronic Cooling (WSE).
4. LonWorks v6.0 or greater is recommended for optimal network communication performance.
5. Hydronic Heating/Cooling not supported by the I/O expansion module.

http://www.DaikinApplied.com
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Table 3: Software Compatibility  – Enfinity Large Two Compressor (SS2C) Models

WSHP Unit Controller
Models CCH/CCW (6-Ton or Greater), LVC/LVW 

Baseboard 
Software: 2508069 

Hardware: 668105601

Baseboard 
Software: 2508088 

Hardware: 668105611
Auxiliary Board Part Number Version v1.0 v1.1 v1.2 v1.1

I/O Expansion Module 
Software: 2508070 

Hardware: 668105702 v1.0 Yes Yes Yes Yes

Software: 2508089 
Hardware: 668105711 v1.0 Yes Yes Yes Yes

BACnet Module Software: 2508071 
Hardware: 668105901

v1.01 Yes Yes Yes Yes
v1.11 Yes Yes Yes Yes
v1.21 Yes Yes Yes Yes
v1.3 Yes Yes Yes Yes

LonWorks Module Software: 2508072 
Hardware: 668105801

v1.02 Yes Yes Yes Yes
v1.1 Yes Yes Yes Yes

1. BACnet software v1.3 or greater is recommended for optimal network communications performance.
2. LonWorks software v1.1 or greater is recommended for optimal network communications performance. 

Table 4: Software Compatibility – Enfinity Two Speed Compressor, Multi-Fan Speed (Series1) Models

WSHP Unit Controller
Models C2H/C2W 

Baseboard 
Software: 2508051 

Hardware: 668105601
Auxiliary Board Part Number Version  v1.0 v1.1 v1.2 v1.3

I/O Expansion Module Software: 2508052 
Hardware: 668105702

v1.0 Yes Yes Yes Yes
v1.1 Yes Yes Yes Yes

BACnet Module Software: 2508053 
Hardware: 668105901

v1.0 Yes Yes Yes Yes
v1.1 Yes Yes Yes Yes

LonWorks Module Software: 2508054 
Hardware: 668105801

v1.0 Yes Yes Yes Yes
v1.1 Yes Yes Yes Yes

Figure 1: Legacy WSHP Unit Controller Software Revision Label (Enfinity)     

Figure 2: Current WSHP Unit Controller Software Revision Label (SmartSource)       

Unit controller software version label.  
Note this is shown for reference only, 
and may not reflect the most current 
version of code.

Unit controller software version label.  
Note this is shown for reference only, 
and may not reflect the most current 
version of code.

http://www.DaikinApplied.com
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Figure 3: BACnet and LonWorks Communication Module Software Version Labels            

Table 5: MicroTech III WSHP – Overview of Board Programming Tools 

MicroTech III WSHP Programming Tools by Unit Controller Part Numbers 
Unit Controller Hardware: 668105611 
I/O Expansion Board Hardware: 668105711

Unit Controller Hardware: 668105601
I/O Expansion Board Hardware: 668105702

Hardware

Renesas E2 Lite or E1 programmer available at
www.renesas.com/us/en/products/software-tools/tools/emulator/
e2-emulator-lite.html 

Renesas E8a programmer, available at www.renesas.com/us/
en/products/software-tools/tools/emulator/e8a.html
The original Segger Flasher5 programmer can also be used to 
program legacy boards. However, it is no longer available from 
the supplier for purchase. Instructions are provided in previous 
versions of OM 1085

Additional custom 6-pin interface cable (Figure 6) that connects 
the unit controller to the Renesas programmer cable.This cable 
is not included in Renesas E2 Lite or E1 programmer kit when 
ordered from Renesas. Contact the ATS Technical Response 
Team at 315-282-6434 to request this cable

Additional custom 10-pin interface cable that connects the unit 
controller JTAG port to Renesas E8a programmer. This cable 
is not included in Renesas E8a programmer kit when ordered 
from Renesas. Contact the ATS Technical Response Team at 
315-282-6434 to request this cable

Software

Renesas Flash Program (RFP) software available at  
www.renesas.com/us/en/software/D3017334.html

Renesas Flash Development Toolkit software available at
www.renesas.com/us/en/products/software-tools/tools/
programmer/flash-development-toolkit-programming-gui.html 

Unit controller software, which is a “.hex” file type and needs 
to be saved to your hard drive. Contact the ATS Technical 
Response Team at 315-282-6434 to request a copy of this file

Unit controller software, which is a “.mot” file type and needs 
to be saved to your hard drive. Contact the ATS Technical 
Response Team at 315-282-6434 to request a copy of this file

No Program/Run jumper is used Program/Run jumper is used
BACnet Communication Module (Applies to all MicroTech III WSHP Unit Controllers)
Hardware
BACnet communication module installed on the WSHP baseboard
1. Segger J-Link programmer, available at www.segger.com or
2. ATMEL SAM-ICE programmer, available at www.DigiKey.com.  Reference AT91SAM-ICE-ND or equivalent
Software
Segger J-Link software and documentation pack for Windows available at www.segger.com/downloads/jlink/#J-
LinkSoftwareAndDocumentationPack
SAM-BA v2.18 software free download available at www.microchip.com/DevelopmentTools/ProductDetails/PartNO/SAM-BA%20
In-system%20Programmer
BACnet .bin file is available by contacting the Controls Customer Support group at 866-462-7829
LonWorks Communication Module (Applies to all MicroTech III WSHP Unit Controllers)
Hardware
LonWorks communication module installed on the WSHP baseboard
Twisted pair cable with 3-pin connector: Echelon TP/FT-10 to USB network interface, U10 or similar
Software
XIF/NXE files - www.DaikinApplied.com or www.lonmark.org
LonWorks application such as OpenLNS CT, or CT available from Echelon at www.echelon.com 

BACnet module software 
version label

LonWorks module software 
version label

http://www.DaikinApplied.com
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Download and Configuration

Unit Controller and I/O Expansion Module
The following describes how to download and verify the WSHP 
unit controller and I/O expansion module software. 

There are two sets of unit controller (baseboard) and 
companion I/O expansion module hardware part numbers. 

The software loaded on the boards varies depending on the 
WSHP model (SmartSource, Enfinity, etc.) 

This section is organized into two separate sub-sections based 
on the programming tools needed to download each set of 
hardware part numbers. 

NOTE:	 Before proceeding, refer to Table 1 - Table 4 in order 
to confirm which version of board(s) you have, and 
thus which tools to use. Figure 1 and Figure 2 show 
where to find the sticker labels on each board.

Downloading to Baseboard #668105611 
or I/O Expansion Module #668105711 
with Renesas E2 Lite or E1 Programmer
Getting Started
You will need the following: 

•	 WSHP unit controller baseboard with hardware part 
number 668105611 or I/O expansion board with hardware 
part number 668105711.  

•	 Renesas E2 Lite or E1 programmer hardware.
•	 Renesas Flash Development (RFP) software. The 

RFP includes the Renesas Project File (.rpj) used for 
determining the configuration settings. Specifications and 
links to the Renesas website provided in Table 5 and see 
Note below.

•	 Computer with a Windows-compatible operating system. 
Refer to www.renesas.com for more information.

•	 WSHP unit controller and I/O expansion module .hex file. 
See Note below. 

NOTE:	 Contact the ATS Technical Support Team at 
315-282-6434 to request a copy of the .hex and/or 
.rpj file. These files can also be downloaded from the 
Daikin Applied website at www.daikinapplied.com/
resources/application-software.

Installing the Renesas E2 Lite or E1 
Programmer
The instructions below apply to downloading the WSHP unit 
controller or I/O expansion board using the Renesas E2 Lite 
programmer (Figure 4). 

The Renesas E1 programmer can also be used but is no 
longer supported. The differences are noted where necessary.

1.	 Acquire the Renesas E2 Lite programmer and interface 
cable as described in Table 5. 

2.	 Download the latest Renesas Flash Programmer (RFP) 
software from the Renesas website at www.renesas.
com/us/en/software/D3017334.htm. 

NOTE:	 It is important that you install the Flash Programming 
software before connecting the programmer to 
the USB port on your computer. The USB driver is 
automatically installed.

3.	 Connect the E2 Lite programmer to the USB port on your 
computer using the USB interface cable. 

a.	 Connect the mini-B plug of the USB interface cable 
to the USB I/F connector of the E2 Lite. 

b.	 Connect the A plug of the USB interface cable to 
the USB port on your computer.

NOTE:	 The E2 Lite is active once connected to the USB 
interface cable.

4.	 Power down the unit controller. 

5.	 Connect the E2 Lite programmer to the MCU:

a.	 Connect the interface ribbon cable to the user-side 
connector of the E2 Lite (Figure 8). 

b.	 Carefully insert the Renesas E2 Lite or E1 
programmer 14-pin connector to the interface 
cable PCB header pins labeled “E1 Emulator” 
(Figure 6 and Figure 7).  

c.	 Connect the 6-pin connector to the CN_PGRM port 
on the control board (Figure 5).

NOTE:	 It is important to identify the red cable wire is next to 
the arrow on the PCB (Figure 8). Figure 9 shows the 
final assembly inserted into the baseboard.

6.	 Apply power to the unit controller.

NOTE:	 Do not remove power from the unit controller 
or unplug the USB interface cable during this 
process. The power supplied from the board to the 
programmer could possibly damage the hardware.

7.	 Open the Renesas Flash Programmer (RFP) software.

8.	 Click Open Project from the File menu. 

9.	 Browse to the Renesas Programmer Project file (.rpj 
file type) and click Open. See the Note at the end of the 
Getting Started section if you do not have this file. 

10.	 Click Browse in the Project File section to select the 
Baseboard or IO Expansion Board (.hex file type) and 
click Open. See the Note at the end of the Getting 
Started section if you do not have this file. 

11.	 If using the E1 programmer, follow steps 11a-b. 
Otherwise, if using the E2 Lite programmer, go to Step 
12.

a.	 From the Connect Settings tab, set the 
Communication Tool to E1.

b.	 Click the Operation tab.

12.	 Click Start to begin programming the board. A pop-up 
message appears and indicates progress during the 
programming process.

http://www.DaikinApplied.com
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13.	 Programming is successful when the green OK message 
appears.

14.	 Power down the board and disconnect the 6-pin E2 
Lite interface cable from the CN_PGRM port of the 
baseboard or IO expansion board.

15.	 Close the RFP software.

Programming is now complete and the board is ready for use.

Figure 4: Renesas E2 Lite Programmer, USB Connector 
and Interface Cable 

Figure 5: MicroTech III Baseboard Programming Port

Figure 6: Custom Interface Cable for Renesas E2 Lite/E1     

Figure 7: Inserting the Renesas E2 Lite 14-Pin Ribbon 
Cable to the PCB Board of the Interface Cable

14-Pin Header to 
Renesas E2-Lite or 
E1 Programmer

6-pin Connection to  
Baseboard or I/O 
Expansion Board

http://www.DaikinApplied.com
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Figure 8: Renesas Programmer Attached to the 6-pin Connection Port of Interface Ribbon Cable       

Figure 9: Programming Hardware Fully Connected

Note the red strip on the ribbon cable is next to the 
small white arrow on the PCB

http://www.DaikinApplied.com


Download and Configuration

www.DaikinApplied.com	 11	 OM 1085-8 • MICROTECH III CONTROLLER

Downloading to Baseboard #668105601 
or I/O Expansion Module #668105702 
with Renesas E8a Programmer
Getting Started
You will need the following: 

•	 WSHP unit controller baseboard with hardware part 
number 668105601 or I/O expansion board with hardware 
part number 668105702.  

•	 Renesas E8a programmer hardware and software 
development kit. Specifications and links to the Renesas 
website provided in Table 5.

•	 Computer with a Windows-compatible operating system. 
Refer to www.renesas.com for more information.

•	 WSHP unit controller or I/O expansion module “.mot” 
file saved to your hard drive. Contact the ATS Technical 
Support Team at 315-282-6434 to request a copy of this 
software file. 

Installing the Renesas E8a Programmer
1.	 Acquire the Renesas E8a programmer and interface 

cable as described in Table 5. 

2.	 Download the latest Renesas Flash Development Toolkit 
software available at www.renesas.com/us/en/products/
software-tools/tools/programmer/flash-development-
toolkit-programming-gui.html. 

NOTE:	 It is important that you install the Flash Development 
Toolkit software before connecting the programmer 
to the USB port on your computer. The USB driver is 
automatically installed.

3.	 Connect the E8a programmer to the USB port on your 
computer using the USB interface cable.

a.	 Connect the mini-plug of the USB interface cable 
to the USB I/F connector of the E8a.

b.	 Connect the plug of the USB interface cable to the 
USB port on your computer.

NOTE:	 The E8a programmer is active once connected to the 
USB interface cable. 

4.	 Power down the unit controller.

5.	 Connect the E8a programmer to the MCU: 

a.	 Connect the interface ribbon cable to the user-side 
connector of the E8a programmer (Figure 10).

b.	 Carefully insert the Renesas E8a 14-pin connector 
to the interface cable PCB header pins labeled 
“E8a Emulator” (Figure 11).  

c.	 Connect the 10-pin connector to the JTAG port on 
the control board.

d.	 Place the RUN/PRG jumper in the PRG position 
(Figure 26).

6.	 Apply power to the unit controller. 

Figure 10: Renesas E8a Programmer with USB and 
Interface Ribbon Cable Connected        

Figure 11: Custom Interface Cable for Renesas E8a 
Programmer       

NOTE:	 Do not remove power from the unit controller 
or unplug the USB interface cable during this 
process. The power supplied from the board to the 
programmer could possibly damage the hardware.

7.	 Open the Renesas Flash Development Toolkit (FDT)
software using the "Flash Development Toolkit 4.09 
Basic" (or newer) shortcut. The software must be 
configured if using the FTD software for the first time to 
download to the unit controller. Proceed to the next step 
to complete this process. Otherwise, skip to Step 20. 

User Side Port 
with 14-pin Ribbon  
Cable Connected  

USB I/F Port with 
Interface Cable 
Connected

14-Pin Ribbon Cable Connection to Custom Inter-
face Cable

H1, 14-Pin Header to Renesas 
E8a Programmer

      H2, 10-Pin Connection to Custom         
      Interface Cable

http://www.DaikinApplied.com
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From the Options tab: 

8.	 Select Auto Disconnect, Readback Verify, Erase Device 
Before Program, and File Over Warning (Figure 12).

NOTE:	 The following screen shots and instructions may vary 
slightly with newer sotware versions. 

Figure 12: Select Options 

From the Options tab:

9.	 Select New Settings.

10.	 Enter M38507 from the Choose Device and Kernel 
menu\Filter section type field (Figure 13).

11.	 Select 740 – M38507F8A and click Next.

Figure 13: Select Device 

From the Communications Port screen (Figure 14):

12.	 Select E8a from the Select Port drop-down menu.

13.	 Check “Set Reset pin as low when disconnecting.”

14.	 Click Next.

Figure 14: Communications Port 

From the Connection Type menu (Figure 15):

15.	 Verify that Recommended Speeds and Use Default are 
checked.

16.	 Click Next.

Figure 15: Connection Type

From the Programming Options menu (Figure 16): 

17.	 Select Automatic Protection and Standard Messaging. 

18.	 Select Yes for Readback Verification.

19.	 Click Finish.

http://www.DaikinApplied.com
http://Next.nw
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Figure 16: Programming Options

From the Options tab (Figure 17):

20.	 Select Other Properties Settings\Auto Send ID.

Figure 17: Other Properties

From the ID Check menu (Figure 18):

21.	 Set all the ID bytes to FF.

22.	 Verify Enable Automatically Verifying ID is checked.

23.	 Click OK.

Figure 18: ID Check

24.	 Select Other Properties Settings\Target Power.

25.	 Click “Memorize the settings in this dialog box until the 
work space is closed” and then click OK (Figure 19).

Figure 19: Target Power Settings

In the File Selection area (Figure 20):

26.	 Confirm Download File and User/Data Area are both 
selected.

27.	 Click on the right arrow then Browse to choose the 
Baseboard or IO Expansion Board controller binary 
software file (.mot file type). Contact the ATS Technical 
Support Team at 315-282-6434 to request a copy of this 
software file. 

28.	 Click Open.

29.	 Click on the Program Flash button.

Figure 20: Select File for Download

http://www.DaikinApplied.com
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From the Select USB Device menu (Figure 21):

30.	 Select the E8a interface and then click OK.

Figure 21: Select USB Device

The download process begins and messages appear in the 
status area at the bottom of the screen.

31.	 Verify the Image Written to Device and Verification OK 
messages are displayed. These messages indicate a 
successful download.

32.	 Close the Renesas Flash Development Toolkit Simple 
software.

33.	 Power down the unit controller.

34.	 Disconnect the E8a programming cable from the board.

35.	 Place the RUN/PRG jumper in the RUN position.

Programming is now complete, and the board is ready to use.

http://www.DaikinApplied.com
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Downloading to Baseboard #668105601 or I/O Expansion Module #668105702 with 
Segger Flasher5 Programmer
The following section describes how to download the unit 
controller baseboard or I/O expansion module using the 
Flasher5 (legacy) programming tool.

Getting Started
You will need the following: 

•	 WSHP unit controller baseboard with hardware part 
number 668105601 or I/O expansion board with hardware 
part number 668105702.  

•	 Segger Flasher5 programmer hardware and software.
•	 Computer with Windows-compatible operating system. 

Refer to www.segger.com for more information.
•	 WSHP unit controller or I/O expansion module “.hex” 

file saved to your hard drive. Contact the ATS Technical 
Support Team at 315-282-6434 to request a copy of this 
software file. 

Installing Segger Flasher5 Software 
If the software has not been previously installed and 
configured, follow steps 1-5 below. Otherwise, skip to step 1 of 
the next section:

1.	 Download the most recent version of Flasher5 software 
from www.segger.com/downloads/flasher.

2.	 Save the application to your hard drive.

3.	 Open the SetupFlasher application; click Next from the 
Welcome screen.

4.	 Click Next from the Choose Destination Location screen 
(Figure 22) to choose the default hard drive location.

5.	 Check all three boxes for available options as shown in 
Figure 23 and click Next.

NOTE:	 The JTAG hardware and software tools referenced 
here are manufactured by Segger Microcontroller 
Systems. However, there are other manufacturers of 
JTAG-supported programming tools that would also 
be acceptable. 

Figure 22:  Choose Destination    

Figure 23: Choose Options    

Once the Flasher software has been installed, follow the 
steps below to download the unit controller and I/O expansion 
module. The unit controller and I/O expansion module have 
different software files and must be downloaded separately. 
NOTE:	 New unit controller software may be installed over 

an existing version. It is not necessary to uninstall 
software prior to loading a newer version. 

1.	 Refer to Table 1 - Table 4 to verify the latest version of 
software.

2.	 Remove power to the unit controller and the BACnet or 
LonWorks communication module (if attached).

3.	 Download the unit controller software, which is a “.hex” 
file type and save to the hard drive. To request a copy of 
the software file, contact the ATS Technical Response 
Team at 315-282-6434.

4.	 Connect the Flasher5 hardware between the serial port 
on the computer (or a USB to serial converter) and the 
10-pin connector on the unit controller or I/O expansion 
module. The Pin1 triangle on the Flasher cable (brown 
wire) must line up with the Pin1 triangle on the board. 
Refer to Figure 24 and Figure 25.

5.	 Connect power to the Flasher5 hardware.

6.	 If a room or return air sensor connected to TB1 or H9 on 
the unit controller, and jumper JP6 is shorted, remove 
this jumper. 

7.	 If a thermostat is connected to TB2 on the unit controller 
and jumper JP6 is not shorted, short-jumper JP6 to 
prevent the unit from running during the download 
process.

8.	 Switch the Programming Jumper from the RUN position 
to the PRG position on the board being downloaded (unit 
controller baseboard or I/O expansion module) as shown 
in Figure 26. 

http://www.DaikinApplied.com
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9.	 If there is an I/O expansion module connected to the unit 
controller being downloaded, verify that the Programming 
Jumper on the I/O expansion module is in the RUN 
position. 

10.	 If the I/O expansion module is being downloaded, verify 
that the Programming Jumper on the unit controller is in 
the RUN position.

11.	 Prior to launching Flasher, check the communication port 
(i.e. COM1 or COM2) to which the Flasher5 hardware 
is connected. The port number is required for Step 13. 
Follow these steps to determine the port number:

Figure 24: Flasher Cable Orientation and Programming 
Jumper   

Figure 25: Flasher Cable Connected to JTAG Port   

Figure 26: Programming Jumper in the PRG Position   

12.	 Navigate to the Control Panel and select System/
Hardware/Device Manager/Ports.

13.	 Verify the communication port shown (i.e. COM1, COM2, 
etc).

14.	 Launch the Flasher program from the desktop shortcut 
icon.

15.	 If this is the first time downloading to the unit controller 
since installing the Flasher program, it is necessary to 
configure the software. If this has already been done, 
proceed to Step 24. Otherwise, follow Steps 16-23.

16.	 Go to the Options menu and select Communications. 
Select the communications port (as determined from 
Step 13) as shown in Figure 27 and then click OK.

Figure 27: Communications Parameters Menu   

17.	 Navigate to the Options menu 

a.	 Click on Device.

b.	 Click Select Device in the Device Properties 
window. See Figure 28.

Figure 28: Device Properties     

When the Select Device window shown in Figure 29 appears:

18.	 Select Renesas in the Manufacturer drop-down box.

19.	 Select M38507 in the Group drop-down box. 

http://www.DaikinApplied.com
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20.	 Highlight the device M38507F8FP with 1KB RAM and 
32KB FLASH and then click the OK button twice.

21.	 Navigate to the Options menu and select Passcode.

Figure 29: Select Device    

22.	 Verify that all seven fields are set to FF as shown in 
Figure 30.

23.	 Click the OK button.

Figure 30: Passcode Configuration Menu    

24.	 Apply power to the unit controller. The Target VCC field 
should change to approximately 5.0 Volts as shown in 
Figure 31. If it does not, check the connection between 
the Flasher5 hardware and unit controller to verify that 
the cable is installed properly.

25.	 Prepare the software file for downloading.

a.	 Go to the File menu and select Open.

b.	 Browse to the appropriate file and click OK. The 
screen should populate as indicated in Figure 31.

26.	 To begin the download, select the Target menu and click 
Program and Verify. After a successful download, the 
screen shown in Figure 32 appears.

Figure 31: Unit Controller when Applying Power and Hex 
File is Loaded    

Figure 32: Flasher Successful Download Screen    

27.	 Remove power from the unit controller and disconnect 
the Flasher5 hardware.

28.	 Switch the programming jumper back from the PRG 
position to the RUN position.

29.	 Repeat steps 1-28 to complete this process for the I/O 
expansion module, if one is attached. 

30.	 After both the unit controller and I/O expansion module 
have been programmed, return the unit controller 
baseboard JP6 configuration jumper to the state it was in 
before step 6.

http://www.DaikinApplied.com
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31.	 Set the unit controller configuration properties to default 
values and calibrate the brownout reference setpoint as 
described in steps a-f. Applies only to the following unit 
controller software versions:

•	 Enfinity Single Stage Compressor with software 
PN 2506900 and 2506901  

•	 SmartSource Single and Two Stage Compressor 
(Series2) with software PN 2508060 and 2508061 

•	 Enfinity Large Two Compressor (SS2C) with 
software PN 2508069 and 2508070

NOTE:	 Only perform the following calibration procedures 
if the unit controller 24VAC voltage is within normal 
operating parameters.  

a.	 Place the unit in the Service Mode by shorting the 
unit controller JP1 configuration jumper.

b.	 Tie a jumper wire from a ground connection to the 
unit controller unoccupied input (‘U’ terminal).

c.	 Apply power to the unit controller and wait for 15 
seconds.

d.	 Remove power from the unit controller.

e.	 Remove the ground wire from the unit controller 
unoccupied input (‘U’ terminal).

f.	 Place the unit in the Normal Operating Mode by 
removing the JP1 configuration jumper.

NOTE:	 It is recommended that these steps are performed 
each time new software is loaded in order to verify 
proper brownout calibration. 

32.	 Apply power to the unit controller for a minimum of 30 
seconds to confirm that the configuration has been saved 
properly.

33.	 If a “Serial EEPROM Corrupted” message appears, cycle 
power to the unit controller to clear the alarm.

http://www.DaikinApplied.com
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Download and Configuration - BACnet

BACnet Communication Module
This section describes how to do the following: 

1.	 Install the programming tools needed for downloading 
BACnet communication module software. 

2.	 Install and configure the BACnet communication module 
software 

There are two programming tools compatible with the BACnet 
communication module. Both are referenced in Table 5. The 
instructions provided here support the J-Link hardware and 
J-Flash ARM software supplied by Segger Microcontroller. 
The second tool is the SAM-BA® boot programmer. SAM-BA 
is considred obsolete and is no longer supported. Refer to a 
previous version of this document (OM 1085-5 or older) for 
download and configuration using SAM-BA. 

Figure 33 shows the important programming features of the 
BACnet communication module for reference during the 
configuration process. 

Figure 33: BACnet Communication Module Main 
Components    

Downloading Segger J-Flash ARM 
Software and J-Link Hardware
You must first configure the J-Flash/J-Link programming 
tools for use with the BACnet communication module. 
Once complete, follow the steps to download the BACnet 
communication module software.  

Getting Started
You will need the following: 

•	 BACnet communication module hardware PN 668105901 
installed on the WSHP unit controller

•	 The latest Segger J-Link hardware (J-Link Plus bundle, 
which includes JTAG ribbon cable and licensed 
hardware) from www.segger.com/products/debug-probes/
j-link/models/j-link-plus/ 

•	 The latest Segger J-Link Software and Documentation 
pack for Windows from www.segger.com/downloads/
jlink/#J-LinkSoftwareAndDocumentationPack 

•	 Computer with a Windows-compatible operating system. 
Refer to www.segger.com for more details

•	 BACnet “.hex” file 
Contact the ATS Technical Support Team at 315-282-6434 to 
receive the file

Installation and Setup
If the software has not been previously installed, follow steps 
1- 7 below.  Otherwise skip to the next section.

1.	 Download the most recent version of J-Link Software and 
documentation pack for Windows from www.segger.com/
downloads/jlink/#J-LinkSoftwareAndDocumentationPack 

NOTE:	 Purchase the J-Link Plus bundle package to make 
sure the hardware is properly licensed for use with 
J-Flash software.

NOTE:	 The following screen shots and instructions may vary 
slightly with newer sotware versions. 

2.	 Open the JLink_Windows application and click Next from 
the welcome screen.

3.	 Review the terms of the license agreement and click 
I Agree.

4.	 Choose the optional component settings as shown in 
Figure 34.

Figure 34: J-Link Setup: Optional Component Settings     

5.	 Click Install.

6.	 Click Finish when prompted. Installation is now complete

7.	 Proceed to the next section.

http://www.DaikinApplied.com
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Launch and Configure the J-Flash ARM 
Software 
Follow the steps below to launch and configure J-Flash ARM.
NOTE:	 Performing the following configuration steps returns 

all BACnet network parameters to default values. 
Record any previously configured settings before 
proceeding. 

1.	 Connect the J-Link hardware between the USB port on 
the computer and the 20-pin connector on the BACnet 
communication module. The notch on the J-Link cable 
fits into an opening on the 20-pin connector on the 
BACnet communication module (Figure 33).

2.	 Launch J-Flash ARM software. The screen shown in 
Figure 35 appears. 

NOTE:	 These instructions are based on J-Flash v7.52x. The 
interface and configuration steps may vary slightly if 
using a different version of the software.

NOTE:	 It is not necessary to create a new project if using 
J-Flash v7.54x or newer. In this case, skip this section 
and go to Configure J-Link Hardware. 

3.	 Select one of the two options from this screen and click 
Start J-Flash. 

A project must be opened or created before J-Flash 
can proceed to the project settings screen.

Figure 35: J-Flash ARM Welcome Screen      

4.	 The Create New Project screen appears (Figure 36). 
Select the "..." to the right of the empty Target device 
field. This opens the Target Device Settings screen 
(Figure 37).

Figure 36: Create New Project      

5.	 Locate the device number from the BACnet 
communication module's ATMEL chip (Figure 33).

Figure 37: Target Device Settings      

6.	 Find this number in the Device column, double-click on 
the row and click OK (Figure 38). The device disappears 
from this list once it has been located.

Figure 38: Target Device Search       

7.	 The name of the Target device appears in the Create 
New Project screen (Figure 39). Click OK. 

http://www.DaikinApplied.com
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Figure 39: Create New Project - Device Found     

Figure 40: Project Information      

Configure J-Link Hardware
Follow these steps to establish the correct hardware settings if 
J-Flash ARM has not been previously configured.

1.	 Navigate to the Options menu and select Project 
Settings.

2.	 Select USB Device 0 from the General tab (Figure 41).

3.	 Select Engineering for the User interface mode, then 
click OK.

Figure 41: Project Settings – General Tab      

4.	 Click on the Target Interface tab (Figure 42).

a.	 Select JTAG from the drop-down box.

b.	 Select 10kHz from theTAG speed before init steps 
section drop-down box.

c.	 Choose Auto detection from JTAG scan 
information.

d.	 Select 4000 kHz from JTAG speed after init steps 
section drop-down box.

e.	 Click OK when all selections have been made.

Figure 42: Target Interface Tab      

5.	 Click on the MCU tab (Figure 43).

6.	 The Device inforormation should automatically display. If 
not, click on the "..." button in the Device area to select 
the Atmel device, AT91SAM7S256.

7.	 Verify the following options are selected and click OK 
when finished: 

http://www.DaikinApplied.com
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a.	 The Check core ID box is selected.

b.	 200000 is in the Addr box.

c.	 64KB is selected from the drop-down menu.

d.	 Clock speed is set to Auto detection.

Figure 43: MCU Tab     

8.	 Click on the Flash tab (Figure 44) and verify the 
following:

a.	 Flash bank = 0 (Internal flash)

b.	 Base Address = 00100000

c.	 Organization = 32

d.	 Bits x = 1 Chip

e.	 In the Sector selection, scroll down to the bottom 
of the list and do the following:

i.	 Check Sector[10211]: 0x0013FD00 - 
0x0013FDFF

ii.	 Uncheck the last two address ranges:

•	 Sector[1022]: 0x0013FE00 - 0x0013FEFF
•	 Sector[1023]: 0x0013FF00 - 0x0013FFFF

f.	 Click OK when all selections have been made

Figure 44: Flash Tab     

9.	 Click on the Production tab (Figure 45) and verify the 
following:

a.	 Erase, Program, Verify, and Start application boxes 
are checked.

b.	 Selected sectors appears in the drop-down box 
next to Erase.

c.	 Via reset pin appears in the drop-down box next to 
Start application.

Figure 45: Production Tab      
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Download and Configuration - BACnet

www.DaikinApplied.com	 23	 OM 1085-8 • MICROTECH III CONTROLLER

10.	 Click on the Performance tab and verify the following 
selections those displayed in Figure 46.

11.	 Click OK to exit the Project Settings menu.

Figure 46: Performance Tab      

12.	 Navigate to the Options menu. Select the Global Settings 
tab (Figure 47) and verify the following:

a.	 The General log level is set to Level 2.

b.	 The Save Project file on close is checked.

c.	 The Load most recent project is selected.

13.	 Click OK to exit the Global Settings menu.

Figure 47: Global Settings     

Downloading BACnet Communication Module  
Software with J-Flash ARM

 CAUTION
The following procedure returns all BACnet parameters to factory default 
values. It is recommended that existing parameters are saved prior to 
starting this process. See the Appendix in the MicroTech III WSHP BACnet 
Communication Module Installation Manual, IM 928, and MicroTech 
III WSHP Protocol Document, ED 15103 (both available on www.
DaikinApplied.com) for additional information.

Follow these steps to use J-Flash ARM to download the 
BACnet communication module's .hex software file:

1.	 Apply power to the unit controller.

2.	 Navigate to Target and select Connect from the main 
J-Flash screen.

3.	 Verify connection by viewing the log message at 
the bottom of the screen that indicates Connected 
Successfully.

4.	 Close any open data files like the one highlighted in red 
(Figure 48).

5.	 Select Open data file… from the File menu.

Figure 48: Successful Connection Message       

6.	 Browse to the location on the hard drive where the 
BACnet communication module .hex file has been saved.

7.	 Click on the “.hex” file and select Open.

8.	 Verify that the Log screen message indicates the data file 
has opened successfully (Figure 49).
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Figure 49: Successful Data File Open Message        

9.	 Remove (if connected) the jumper from pin 1 and pin 2 
on J2 of the BACnet communication module.

10.	 Press the F7 key to begin production programming.

NOTE:	 If this does not work, another option is to use 
Production Programming from the Target Interface 
menu.

11.	 Click OK when the screen shown in Figure 50 appears 
and programming is complete.

Figure 50: Target Erased, Programmed, and Verified 
Successful      

12.	 Remove power from the unit controller.

13.	 Remove the JTAG cable connection from the BACnet 
communication module.

14.	 Press and hold the Default and Reset push buttons on 
the BACnet communication module as shown in Figure 
33.

15.	 Apply power to the unit controller.

16.	 Release the Reset push button, and continue to hold the 
Default push button until all four BACnet communication 
module LEDs (D1 to D4) are on steady (Figure 33).

17.	 Verify that application is operating correctly by observing 
the following LED activity:

a.	 LED D1 flashes on and off approximately every 
half second. This indicates that the application is 
running.

b.	 LED D2 flashes in bursts approximately every half 
second. This indicates communication between 
the unit controller and the BACnet communication 
module.

c.	 LED D3 flashes for each message transmitted to 
the MS/TP network.

d.	 LED D4 flashes for each message received from 
the MS/TP network.

All BACnet communication parameters have now been 
returned to default settings. Reconfigure network values as 
required. See ED 15103, available on www.DaikinApplied.com, 
for further details.

NOTE:	 Refer to the Troubleshooting Guide and FAQ section. 
If necessary, contact the Controls Customer Support 
group at 866-462-7829 for technical assistance.

http://www.DaikinApplied.com
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LonWorks Communication Module
The following section describes how to download and 
commission the LonWorks communication module software 
files (XIF - eXternal Interface File and NXE file) for the 
WSHP unit controller. This is done using industry-standard 
LonWorks-specific software such as Echelon® LonMaker. It 
is assumed that the user has the application installed and is 
familiar with the use of LonMaker or equivalent software.

Getting Started
You will need the following:

•	 LonWorks communication module installed on unit 
controller with PN 668105801

•	 XIF/NXE files for the LonWorks communication module, 
available on www.DaikinApplied.com or  
www.lonmark.org

•	 LonWorks application such as Echelon® CT 
(Commissioning Tool), available at, available 
at www.echelon.com. 

Note that a 32-bit version of Visio software and also 
.NET v4.8 Windows framework is needed. It is also 
recommended that .NET v3.5 remain installed in 
order to support other PC applications not related to 
the Echelon CT Tool.

•	 Twisted pair shielded cable with 3-pin connector

•	 Echelon TP/FT-10 to USB network interface, U10 or similar
•	 Computer with Windows-compatible operating system 

Refer to www.echelon.com for details
•	 Standard web browser for access to  

www.DaikinApplied.com

Installation and Setup
1.	 Verify that LonWorks software such as LonMaker SR4 

or CT is installed. 

2.	 Verify that a LonWorks communication module is 
properly installed on the unit controller. Refer to IM 927, 
available on www.DaikinApplied.com.

3.	 Download the LonWorks communication 
module XIF/NXE files to your hard drive. Refer to  
www.DaikinApplied.com or www.lonmark.org.

4.	 Connect TP/FT-10 network channel to the computer 
using the USB network interface.

Figure 51: LonWorks Interface Name     

5.	 Determine the LonWorks Interface name for later 
reference. Do this by navigating to Control Panel/ 
LonWorks Interfaces (Figure 51).

6.	 Insert the other end of the TP/FT-10 connector to 
the LonWorks communication module pins A and B 
(Figure 52).

7.	 Apply power to the unit controller.

Figure 52: Communication Module Main Components        

NOTE:	 If device has not been commissioned, the yellow 
Service LED flashes ON/OFF once every half 
second. See Troubleshooting Guide and FAQ.

LonWorks Software   
Version Label

TB1 Network Connector
Pin3: No Connection
Pin2: Signal B / -
Pin1: Signal A / +

Service LED

FT 3150 Smart 
Transceiver

Service Pin

Pin1

Pin2

Pin3
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Configuring the LonWorks 
Communication Network
The following section describes how to create a LonWorks 
communication network drawing and import the WSHP Device 
Template into the network using CT.

1.	 Open the Echelon IzoT Commissioning Tool. The Design 
Manager screen appears (Figure 53).

NOTE:	 The following screen shots and instructions may vary 
slightly with newer sotware versions. 

Figure 53: IzoT Commissioning Tool Design Manager     

2.	 Either create a new network or select an existing 
network.

a.	 To select an existing network:

i.	 Select the network from the Drawing directory 
drop-down menu.

ii.	 Click on Open Network.

iii.	 Proceed to the Commissioning the 
LonWorks Communication Module section.

f.	 To create a new network: 

i.	 Enter a name in the Network name field and 
then click Create Network.

3.	 Select the Network Interface Name (Figure 54) as 
determined from step 5 of the Installation and Setup 
section (Figure 51).

Figure 54: LonWorks Interface Name  

4.	 Click Next.

5.	 Verify the Management Mode is OnNet and click Finish 
(Figure 55).

Figure 55: Management Mode      

6.	 A screen similar to Figure 56 appears.

7.	 Drag the Device icon (shown on the left-hand side of the 
image in Figure 56) to the center of the screen.

Figure 56: LNS Network Interface Screen      

http://www.DaikinApplied.com
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8.	 The New Device Wizard then opens (Figure 57).

9.	 Provide a Device name and then select Create new 
device template.

10.	 Click Next. The screen shown in Figure 58 appears.

Figure 57: New Device Template       

11.	 Ensure that Load XIF is selected.

12.	 Click Browse to locate the LonWorks communication 
module XIF file from the hard drive and then click Finish.

Figure 58: XIF Definition        

13.	 The network drawing screen now displays the new 
device (Figure 59).

14.	 The MTIII WSHP LonWorks device appears in yellow, 
indicating the device is decommissioned.

Figure 59: Network Drawing      

Commissioning the LonWorks  
Communication Module
The LonWorks communication module is ready for network 
commissioning after the Device Template has been properly 
loaded into CT using the XIF file and the WSHP device exists 
in the network drawing area (Figure 59).

Follow these steps to begin the commissioning process:

1.	 Right click on the decommissioned LonWorks device and 
select Commissioning and then left click on Commission.

2.	 Select both Load application image and Update firmware 
in device to match application image (Figure 60).

Figure 60: Application Image Details    

3.	 Click Browse to locate the LonWorks communication 
NXE Image file from where it was saved and then click 
Next.

http://www.DaikinApplied.com
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4.	 Verify that the following are all selected from the screen 
shown in Figure 61:

•	State setting = Online

•	Source of CP Values setting = Defaults and Include 
NV type CPs

•	Device Specific CPs setting = Update with other 
CPs

5.	 Click Next.

Figure 61: Device Details     .

6.	 Verify that Service pin is selected and then click Finish 
(Figure 62).

Figure 62: Service Pin Screen     

7.	 The screen in Figure 63 appears.

8.	 Press the service pin button on the LonWorks 
communication module. Refer to Figure 52 for the 
location of the service button.

Figure 63: Service Pin Entry     

At this point, the application image starts loading the 
LonWorks communication module. This process takes 
approximately one minute (Figure 64).

The MTIII WSHP device changes color to green which 
indicates successful commissioning (Figure 65).

Figure 64: Loading Application     

Figure 65: LonWorks Communication Module – 
Commissioned     

In order to program another LonWorks device, it is necessary 
to first decommission the existing device by following these 
three steps:

1.	 Right click on the commissioned LonWorks device

2.	 Select Commissioning

3.	 Left click on Decommission

http://www.DaikinApplied.com
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Troubleshooting Guide and FAQ

The following Troubleshooting Guide is intended to be a 
helpful reference and source of supplemental information. It 
provides answers to common questions about the controls 
subjects covered in previous sections of this manual. The 

troubleshooting topics are organized into five categories: 
WSHP equipment configuration, unit controller and I/O 
expansion modules, BACnet or LonWorks communication 
modules, Flasher tools, and finally J-Link tools. 

WSHP Equipment Configuration
This section describes the equipment options for each model. 
Table 5 - Table 16 show the hardware jumper settings used by 

the unit controller and I/O expansion module and summarize 
the valid configuration options by model.

Enfinity Single Stage Compressor Control

Table 5: Unit Controller Configuration Jumpers for Enfinity Single Stage Compressor

Unit Controller Option Hardware Jumpers Setting Description

Normal / Test Mode JP1
JP1 = Open Normal Operation
JP1 = Shorted Service / Test Mode

Fan Operation JP2
JP2 = Open Continuous Fan Operation (ON)
JP2 = Shorted Cycling Fan Operation (AUTO)

Loop Fluid JP3
JP3 = Open Water Loop Fluid
JP3 = Shorted Glycol Loop Fluid

Alarm “A” Terminal Polarity Select (v3.1 & Newer) JP4
JP4 = Open Fault de-energizes alarm output to 0VAC.
JP4 = Shorted Fault energizes alarm output to 24VAC.

Room Sensor Setpoint Adjust Range JP5
JP5 = Open Short Range: -3 to +3 ºF (-1.67 to +1.67 ºC)
JP5 = Shorted Long Range: 55 to 95 ºF (12.78 to 35 ºC)

Thermostat / Room Sensor JP6
JP6 = Open Thermostat Control
JP6 = Shorted Room Sensor Control

Not Used JP7 JP7 = Open —
Not Used JP8 JP8 = Open —

Table 6: I/O Expansion Module Configuration Jumpers for Enfinity Single Stage Compressor

I/O Expansion Module Option Hardware Jumpers Setting Description

Number of Compressors JP1
JP1 = Open Single Compressor
JP1 = Shorted Dual Compressor

Dehumidification JP2
JP2 = Open None
JP2 = Shorted HGR Dehumidification

Secondary Heating JP3 & JP4

JP3 = Open
None

JP4 = Open
JP3 = Shorted

Supplemental Electric Heat
JP4 = Open
JP3 = Open

Boilerless Electric Heat
JP4 = Shorted

Fan Speed Selection JP5 & JP6

JP5 = Open
Single Speed Fan

JP6 = Open
JP5 = Shorted

Two Speed Fan
JP6 = Open
JP5 = Open

Three Speed Fan
JP6 = Shorted

Not Used JP7 JP7 = Open —

Lead Compressor Select (v3.1 & Newer) JP8
JP8 = Open Compressor #1 is Lead 
JP8 = Shorted Compressor #2 is Lead (Dual Compressor Models Only)
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Table 7: Model Types and Options for Enfinity Single Stage Compressor

Model Number Number of 
Compressors 1 Speed Fan 2 Speed Fan 3 Speed Fan HGR Dehumid Supplemental 

Electric Heat
Boilerless 

Electric Heat
11 Single X — — — — —
2 Single X — — X — —
3 Single X — — — X —
4 Single X — — — — X
5 Single X — — X X —
6 Single X — — X — X
7 Single — X — — — —
8 Single — X — X — —
9 Single — X — — X —
10 Single — X — — — X
11 Single — X — X X —
12 Single — X — X — X
13 Single — — X — X —
14 Single — — X — — X
15 Single — — X X X —
16 Single — — X X — X
17 Dual X — — — — —
18 Dual X — — X — —

1 Except for the Enfinity single-compressor WSHP with no other options selected, all Enfinity models require both the unit controller and I/O expansion module.
2 An “X” means that option is available for the corresponding WSHP model.

SmartSource Single and Two Stage Compressor (Series2) and SmartSource 
Compact

Table 8: Unit Controller Configuration Jumpers for SmartSource Single and Two Stage Compressor (Series2) and 
SmartSource Compact

Unit Controller Option Hardware Jumpers Setting Description

Normal / Test Mode JP1
JP1 = Open Normal Operation
JP1 = Shorted Service / Test Mode

Fan Operation JP2
JP2 = Open Continuous Fan Operation (ON)
JP2 = Shorted Cycling Fan Operation (AUTO)

Loop Fluid JP3
JP3 = Open Water Loop Fluid
JP3 = Shorted Glycol Loop Fluid

Freeze Fault Protection JP4
JP4 = Open LWT Freeze Fault Protection is Disabled
JP4 = Shorted LWT Freeze Fault Protection is Enabled

Room Sensor Setpoint Adjust Range JP5
JP5 = Open Short Range: -5 to +5 ºF (-2.78 to +2.78 ºC)
JP5 = Shorted Long Range: 55 to 95 ºF (12.78 to 35 ºC)

Thermostat / Room Sensor JP6
JP6 = Open Thermostat Control
JP6 = Shorted Room Sensor Control

Compressor Heating Source JP7
JP7 = Open Allow Compressor Heating Mode Operation
JP7 = Shorted Disable Compressor Heating Mode Operation

I/O Expansion Module JP8
JP8 = Open I/O Expansion Module is Not Present
JP8 = Shorted I/O Expansion Module is Required
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Table 9: I/O Expansion Module Configuration Jumpers for SmartSource Single and Two Stage Compressor (Series2) and 
SmartSource Compact

I/O Expansion Module Option Hardware Jumpers Setting Description

Fan Row Selection (V6.2 & Newer) JP1 & JP2 — Fan row selection for the: FanOnly, Hydronic Heating, and Hydronic Cooling 
machine states.

Secondary Heating JP3 & JP4

JP3 = Open
None

JP4 = Open
JP3 = Shorted

Supplemental Electric Heat
JP4 = Open
JP3 = Open

Boilerless Electric Heat
JP4 = Shorted
JP3 = Shorted

Hydronic Heating (v6.0 & Newer)
JP4 = Shorted

Cooling / Dehumidification JP5 & JP6

JP5 = Open
None

JP6 = Open
JP5 = Shorted

HGR Dehumidification
JP6 = Open
JP5 = Open

Hydronic Cooling (Waterside Economizer)
JP6 = Shorted

Not Used JP7 JP7 = Open —

Compressor Capacity JP8
JP8 = Open Single Stage Compressor
JP8 = Shorted Dual Stage Compressor

Table 10: Model Types and Options for SmartSource Single and Two Stage Compressor (Series2) and SmartSource 
Compact3

Model  
Number

Compressor  
Type

Supplemental 
Electric Heat

Boilerless  
Electric Heat

Hydronic  
Heat2 HGR Waterside  

Economizer
11 Single Stage — — — — —
2 Single Stage — — — X —
3 Single Stage — — — — X
4 Single Stage X — — — —
5 Single Stage X — — X —
6 Single Stage X — — — X
7 Single Stage — X — — —
8 Single Stage — X — X —
9 Single Stage — X — — X
10 Single Stage — — X — —
11 Single Stage — — X X —
12 Single Stage — — X — X
13 Two Stage — — — — —
14 Two Stage — — — X —
15 Two Stage — — — — X
16 Two Stage X — — — —
17 Two Stage X — — X —
18 Two Stage X — — — X
19 Two Stage — X — — —
20 Two Stage — X — X —
21 Two Stage — X — — X
22 Two Stage — — X — —
23 Two Stage — — X X —
24 Two Stage — — X — X

1 Except for SmartSource Two Stage Compressor (Series2) WSHP with a single speed fan with no options selected, all other SmartSource Two Stage Compressor 
(Series2) WSHPs require both the unit controller and I/O expansion module. 

2 Hydronic heating is only available for unit controller software v6.0 and newer.
3 An “X” means that option is available for the corresponding WSHP model.
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Enfinity Large Two Compressor (SS2C)
Table 11: Unit Controller Configuration Jumpers for Enfinity Large Two Compressor (SS2C) 

Unit Controller Option Hardware Jumpers Setting Description

Normal / Test Mode JP1
JP1 = Open Normal Operation
JP1 = Shorted Service / Test Mode

Fan Operation JP2
JP2 = Open Continuous Fan Operation (On)
JP2 = Shorted Cycling Fan Operation (Auto)

Loop Fluid JP3
JP3 = Open Water Loop Fluid
JP3 = Shorted Glycol Loop Fluid

Freeze Fault Protection JP4
JP4 = Open LWT Freeze Fault Protection is Disabled
JP4 = Shorted LWT Freeze Fault Protection is Enabled

Room Sensor Setpoint Adjust Range JP5
JP5 = Open Short Range: -5 to +5 ºF (-2.78 to +2.78 ºC)
JP5 = Shorted Long Range: 55 to 95 ºF (12.78 to 35 ºC)

Thermostat / Room Sensor JP6
JP6 = Open Thermostat Control
JP6 = Shorted Room Sensor Control

Compressor Availability JP7 & JP8

JP7 = Open
Both Compressors Available (Automatic Compressor Fail Replace)

JP8 = Open
JP7 = Shorted

Lead Compressor Available (Lag Compressor is Off-Line)
JP8 = Open
JP7 = Open

No Compressors Available
JP8 = Shorted

Table 12: I/O Expansion Module Configuration Jumpers for Enfinity Large Two Compressor (SS2C) 
I/O Expansion Module Option Hardware Jumpers Setting Description

Not Used JP1 JP1 = Open —
Not Used JP2 JP2 = Open —

Secondary Heating JP3 & JP4

JP3 = Open
None

JP4 = Open
JP3 = Shorted

Supplemental Electric Heat
JP4 = Open
JP3 = Open

Boilerless Electric Heat
JP4 = Shorted
JP3 = Shorted

Hydronic Heating
JP4 = Shorted

Cooling / Dehumidification JP5 & JP6

JP5 = Open
None

JP6 = Open
JP5 = Shorted

HGR Dehumidification
JP6 = Open
JP5 = Open

Hydronic Cooling (Waterside Economizer)
JP6 = Shorted

Not Used JP7 JP7 = Open —

Lead Compressor Select JP8
JP8 = Open Compressor #1 is Lead
JP8 = Shorted Compressor #2 is Lead

Table 13: Model Types and Options for Enfinity Large Two Compressor (SS2C)1,2

Model Number Supplemental Electric Heat Boilerless Electric Heat Hydronic Heating HGR Dehumid Waterside Economizer
1 — — — — —
2 X — — — —
3 — X — — —
4 — — X — —
5 — — — X —
6 X — — X —
7 — X — X —
8 — — X X —
9 — — — — X

10 X — — — X
11 — X — — X

1 All Enfinity Large Two Compressor (SS2C) WSHP models require both the unit controller and I/O expansion module.
2 An “X” means that option is available for the corresponding WSHP model.
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Two Speed Compressor, Multi-Fan Speed (Series1) 

Table 14: Unit Controller Configuration Jumpers for Two Speed Compressor, Multi-Fan Speed (Series1) 

Unit Controller Option Hardware Jumpers Setting Description

Normal / Test Mode JP1
JP1 = Open Normal Operation
JP1 = Shorted Service / Test Mode

Fan Operation JP21
JP2 = Open Continuous Fan Operation (ON)
JP2 = Shorted Cycling Fan Operation (AUTO)

Loop Fluid JP3
JP3 = Open Water Loop Fluid
JP3 = Shorted Glycol Loop Fluid

Not Used JP4 JP4 = Open —

Room Sensor Setpoint Adjust Range JP5
JP5 = Open Short Range: -3 to +3 ºF (-1.67 to +1.67 ºC)
JP5 = Shorted Long Range: 55 to 95 ºF (12.78 to 35 ºC)

Thermostat / Room Sensor JP6
JP6 = Open Thermostat Control
JP6 = Shorted Room Sensor Control

Fan Speed Selection JP7 & JP8

JP7 = Open
Single Speed Fan

JP8 = Open
JP7 = Shorted

Two Speed Fan (User Selectable)
JP8 = Open
JP7 = Open

Three Speed Fan (Automatic)
JP8 = Shorted

1JP2 setting applies only if: (1) there is a room sensor and (2) the room sensor does not have the Fan ON/AUTO switch input option wired.

Table 15: I/O Expansion Module Configuration Jumpers for Two Speed Compressor, Multi-Fan Speed (Series1) 
I/O Expansion Module Option Hardware Jumpers Setting Description

Compressor JP1 & JP2

JP1 = Open
Single Compressor, Single Stage Capacity

JP2 = Open
JP1 = Shorted

Single Compressor, Dual Stage Capacity
JP2 = Open
JP1 = Open

Dual Compressor, Single Stage Capacity
JP2 = Shorted

Secondary Heating JP3 & JP4

JP3 = Open
None

JP4 = Open
JP3 = Shorted

Supplemental Electric Heat
JP4 = Open
JP3 = Open

Boilerless Electric Heat
JP4 = Shorted
JP3 = Shorted

Hydronic Heating
JP4 = Shorted

Dehumidification JP5 & JP6

JP5 = Open
None

JP6 = Open
JP5 = Shorted

HGR Dehumidification
JP6 = Open
JP5 = Open

Half Stage Dehumidification
JP6 = Shorted

Not Used JP7 JP7 = Open —
Not Used JP8 JP8 = Open —
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Table 16: Model Types and Options for Two Speed Compressor, Multi-Fan Speed (Series1)2 

Model 
Number

Number of 
Compressors

Number of 
Compressor 

Capacity 
Stages

1 Speed Fan 2 Speed Fan 
(User)

3 Speed Fan 
(Auto)

Supplemental 
Electric Heat

Boiler-less 
Electric 

Heat
Hydronic 

Heat HGR Half Stage 
Cooling 

1 One1 One X — — — — — — —
2 One One X — — X — — — —
3 One One X — — — X — — —
4 One One X — — — — X — —
5 One One X — — — — — X —
6 One One X — — X — — X —
7 One One X — — — X — X —
8 One One — X — — — — — —
9 One One — X — X — — — —

10 One One — X — — X — — —
11 One One — X — — — X — —
12 One One — X — — — — X —
13 One One — X — X — — X —
14 One One — X — — X — X —
15 One One — — X — — — X —
16 One One — — X X — — X —
17 One One — — X — X — X —
18 One Two X — — — — — — —
19 One Two X — — — X — — —
20 One Two X — — — — X — —
21 One Two X — — — — — X —
22 One Two X — — — X — X —
23 One Two — — X — — — — X
24 One Two — — X — X — — X
25 One Two — — X — — X — X
26 One Two — — X — X — X —
27 Two One X — — — — — — —
28 Two One X — — — — — X —

1 Except for Two Speed Compressor (Series1) WSHP with no options selected, all other Two Speed Compressor (Series1) WSHP model types require both the unit 
controller and I/O expansion module. 
2 An “X” means that option is available for the corresponding WSHP model.
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WSHP Unit Controller and I/O 
Expansion Module
The following section describes common issues and the 
troubleshooting steps for the unit controller with or without 
an I/O expansion module. Refer to the applicable OM in 
the Reference Documents section, available on www.
DaikinApplied.com, for complete details about LED activity, 
faults, and additional troubleshooting topics.

Q: Room Sensor LED does not come ON, or comes ON for 
a little while, then goes out

A: This could be caused by incorrect voltage to the unit 
controller, incorrect wiring from the unit controller to the 
room sensor LED, defective hardware, or the unit is 
operating in the bypass occupancy mode.

•	 Verify that the programming jumper is tightly installed and 
in the RUN position and not PRG

•	 Verify that the unit controller has 24 VAC
•	 Verify that the unit is not operating in the bypass 

occupancy mode
•	 Verify if the unit runs/communicates when the LED is OFF
•	 If it runs properly without the LED, check the LED wiring 

connection
•	 Download application code to the unit controller
•	 Replace hardware, if necessary

Q: Unit has a room sensor and is constantly in cooling 
mode or the space temperature consistently reads 
higher than actual room temperature
While the unit controller has separate connections for both 
return air and room temperature sensors, it is not possible 
for both to be used at the same time. If both sensors are 
connected, it causes the room temperature to read higher 
than the actual temperature.

A: Disconnect the return air sensor.

Q: Unit is experiencing nuisance high pressure trips
A: High pressure trips can be caused by a faulty pressure 

switch, an improperly designed water system, or possibly 
a software error. High pressure switches can come loose, 
especially when the compressor is running. The connection 
could be compromised at the unit controller, a Molex 
connector in the middle of the switch wire, or where the 
wires land on the switch.

•	 Contact the ATS Technical Support Team at 
315-282-6434 to discuss any issues that may be related 
to the design of the water loop itself.

•	 Verify that the high pressure switch connection to the unit 
controller is secured tightly to the unit controller.

•	 If all the options have been explored, then the issue may 
be related to a condition in the Enfinity Single Stage 
Compressor software that creates nuisance high pressure 
alarms. This condition is seen approximately once every 
1000+ compressor cycles.

NOTE:	 For Enfinity Single Stage Compressor units with 
software 2506900 (v2.6 or older) OR units with 
software 2506901 (v2.7 or older): update the unit 
controller to v3.2 or newer and I/O expansion module 
to v3.0 or newer.

BACnet and LonWorks 
Communication Modules
The following section describes issues and troubleshooting 
steps that apply to both BACnet and LonWorks 
communication modules.

Q: Cannot write to network setpoint or network space 
temp input and space temp reads 621.806 (Analog Null)

A: The unit has been set up for thermostat control.

•	 Use a jumper to short JP6 on the unit controller to enable 
room sensor control.

Q: Cannot write to network setpoint input but space temp 
reads valid value

A: The room sensor setpoint adjustment has been enabled. 
For LonWorks, set nciLocSetEnable to “Disable” or for 
BACnet, set MSV 14 to “1” (defaults are “Enable” and “2.”)

Q: Network inputting space temperature, but space temp 
fault indicated

A: The Enfinity Single Stage Compressor unit controller, 
with software v2.8 or newer, always indicates a space 
temperature fault if there is an open or short on both the 
room sensor and the return air sensor inputs. This occurs 
regardless of a network input for the space temperature. In 
unit controller software v2.9 and newer, the network input 
can be used without a hardwired sensor connection.

•	 Install a 10K ohm resistor on either the room sensor input 
or return air sensor input

•	 Upgrade unit controller and I/O expansion module 
software to version to v2.9 or newer.

Q: Unit constantly gives an Invalid Jumper Configuration 
alarm

A: A Two Speed Compressor, Multi-Fan Speed (Series1) unit 
installed with a room sensor may experience an alarm 
because the software does not support this configuration. 

•	 Replace the unit controller software with v1.2 or newer. 
Refer to the "MicroTech III WSHP Software Compatibility" 
section to confirm current software version and 
compatibility among auxiliary boards, if attached.

•	 Change the unit to thermostat control by shorting the JP6 
configuration jumper. 

	— Until the replacement thermostats arrive or a newer 
version of the software is installed, configure the 
unit to run as a single-speed compressor unit by 
performing the following:

1.	 Disable two-speed compressor capacity by removing 
jumper JP1 on the I/O expansion module.

2.	 Disable half-stage cooling, if applicable, by removing 
jumper JP6 on the I/O expansion module.
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BACnet Communication Module Only
The following section applies only to the BACnet MS/TP 
communication module.

Light Emitting Diodes (LEDs)
The BACnet communication module has four LEDs that 
indicate the status of the module, the connection to the unit 
controller and/or BACnet network. These LEDs are useful for 
verifying communication between the unit controller and the 
network, as well as diagnosing a potential problem. Table 17 
provides a description of the LED activity. For more details, see 
IM 928, available on www.DaikinApplied.com.

Table 17: BACnet Communication Module - LED Activity
LED Function Description
D1 Program Running Program main loop activity

D2 Unit Controller Message SPI Activity, LED on during unit controller 
message

D3 MS/TP Transmit Flashes on when transmitting a MS/TP 
message

D4 MS/TP Receive Flashes on when receiving a MS/TP 
message

Q: No LEDs are lit
A: The communication module may not be properly installed or 

may not have the BACnet application software loaded.

•	 Remove the communication module and then reinstall 
it, verifying that the connector lands on all of the pins (it 
is very easy to either miss just one pin or all of the pins 
even with the standoffs).

•	 If the communication module is properly installed, try it 
on a different, functioning unit. If the LEDs still do not 
function properly, replace the communication module.

•	 Re-download the BACnet software in the communication 
module. Contact the Controls Customer Support 
group at 866-462-7829 before proceeding with this 
option.

Q: All four LEDs are lit
A: The BACnet application software has not been properly 

downloaded.

•	 Re-download the BACnet software in the communication 
module.

•	 Replace the BACnet communication module.

Q: Program LED (D1) never blinks
A: The BACnet software is not running correctly in the 

communication module.

•	 Re-download the BACnet software in the communication 
module.

•	 Replace the BACnet communication module.

Q: SPI Comm LED (D2) never blinks
A: The communication module is not communicating with the 

unit controller.

•	 Verify that the programming jumper on the baseboard is 
in the RUN position and not the PRG position.

•	 Verify that unit controller is controlling the water source 
heat pump unit.

•	 Re-download the unit controller application code.
•	 Re-download the BACnet software in the communication 

module.
•	 Install the communication module on a different, 

functioning unit to determine if the problem is associated 
with the unit controller or the communication module.

Q: RX LED (D4) never blinks
A: The communication module is not communicating with the 

network.

•	 Verify the BACnet MS/TP settings through the serial port 
on the communication module (check baud rate and any 
potential addressing conflicts).

•	 Verify proper network wiring.
•	 Re-download the BACnet software in the communication 

module.
•	 If the network settings are correct and the application 

software is functioning properly, this could indicate a 
hardware defect. Replace the communication module, if 
necessary.

Q: CRC errors
A: The BAS indicates “CRC errors” at the workstation.

•	 Upgrade the communication module to the newest 
version of BACnet software. It is not necessary to 
upgrade the unit controller or I/O expansion module 
software.

Q: Communication module cannot be configured through 
serial port

A: This could be caused by an incorrect or defective cable 
used to configure the communication module, software 
installation error, a previous change in the serial port 
settings, or potentially defective hardware.

•	 Verify that the communication module is connected with 
a DB9 female-female (modem-modem) serial cross-over 
cable. Refer to the MicroTech III WSHP Unit Controller 
Protocol Document, ED 15103, available on www.
DaikinApplied.com.

•	 Confirm that the serial terminal device application settings 
are correct. . Refer to the MicroTech III WSHP Unit 
Controller Protocol Document, ED 15103, available on 
www.DaikinApplied.com. 

•	 Verify that the LED activity is normal. See Table 17.
•	 Try resetting the communication module back to original 

default settings.
•	 Re-download the BACnet software in the communication 

module. 
•	 Replace the communication module, if necessary.
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LonWorks Communication Module Only
The following section applies only to the LonWorks 
communication module.

The LonWorks communication module has a Service 
LED that indicates the status of the module itself and 
the LonWorks network. This LED is useful for verifying 
communication between the LonWorks communication 
module and the network, and for diagnostic purposes. Table 
18 provides a description of the LED activity. Refer to the 
LonWorks Communication Module Installation Manual, IM 927, 
available on www.DaikinApplied.com.

Table 18: LonWorks Communication Module - LED 
Activity 
LED Activity Description
LED flashes once when power has 
been applied, or comes ON when 
pressing the Service switch 

Normal operation for a commissioned 
LonWorks communication module

LED is OFF continuously as soon as 
power is applied Faulty hardware or power supply

LED is ON continuously, even when 
power is first applied Faulty hardware or power supply

LED flashes when power is applied, 
goes OFF, then comes ON solid

Indicates the communication module 
does not have the application image 
(APB/NXE) and interface (XIF) files 
properly installed - reload application 
files, which can be found on www.
DaikinApplied.com or www.lonmark.
org

LED flashes briefly once every second 

The communication module could 
be experiencing an error with the 
application software or possibly 
the hardware - reload application 
files, which can be found on www.
DaikinApplied.com or www.lonmark.
org

LED steadily blinks ON and OFF at ½ 
Hz Rate (1 Sec = ON; 1 Sec = OFF)

Normal operation if the communication 
module is decommissioned

Q: Service Pin LED does not light when pressed
A: The communication module may not be installed properly, 

the hardware may be defective, or the LED itself may be 
defective.

•	 Remove the communication module and then re-install it, 
making sure the connector snaps into place on all four of 
the pins. Use caution as it is easy to either miss just one 
pin or all of the pins, even with the standoffs.

•	 Verify if the BAS recognizes the Neuron ID, even if the 
LED is not lit.

•	 If the communication module is properly installed but 
no Neuron ID is broadcast, remove the communication 
module and install it on a different unit. If the LED does 
not function correctly and/or the BAS still does not 
recognize the Neuron ID, replace the communication 
module. 

Q: The BAS does not “see” some or all LonWorks 
Configuration Properties 

A: The communication module uses multiple User-defined 
Configuration Property Types (UCPTs) to pass Daikin-
specific unit information to the BAS. If the BAS can access 
LonWorks network variables contained in the XIF file, 
then it is likely that the BAS is not allowing access to these 
user-defined configuration properties or has not properly 
implemented the Resource Files giving access to the direct 
memory read-write CPs.

•	 The controls integrator should contact his/her technical 
support to determine how to allow the BAS to access 
configuration properties.

•	 The complete set of LonWorks files required for BAS 
integration are available on www.DaikinApplied.com or 
www.echelon.com should it be necessary to reinstall 
them.

Factory-installed LonWorks communication modules are 
loaded with all application files required for network integration.

Segger Flasher5 Tools
The following section summarizes common issues with Flasher 
tools and the corresponding solutions.

Q: The main screen does not populate with the proper 
Flasher information 

A: See Figure 66. This may indicate a problem with the 
connection between Flasher and the computer 

•	 Verify that the Flasher tool has power and that the 
Flasher serial cable is connected to the computer. 

•	 Additionally, check that the communications port selected 
in the ‘Communications’ section of the ‘Options’ menu is 
set to the correct port (i.e. the port to which the Flasher 
tool is connected).

Figure 66: Main Screen Does Not Populate     
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Q: The Flasher tool’s LED is red
A: Disconnect and remove power from Flasher. After a few 

seconds, reapply power to Flasher. Connect it to the unit 
controller again, verifying that the triangle on the 10-pin 
connector of Flasher is properly installed on the keyed 
connector on the unit controller’s 10-pin JTAG port. See 
Figure 25 and Figure 25.

Q: After applying power, the Target VCC field changes to a 
value that is too low

A: See Figure 67. This could indicate a communication error 
between Flasher and the unit controller. Verify that the 
Flasher 10-pin connector is properly connected to the 
keyed 10-pin JTAG connector port on the unit controller. 
Also verify that the unit controller is connected and powered 
properly. See Figure 25.

Figure 67: Incorrect Target VCC Value     

Q: After preparing the file to be downloaded, the Range and/or 
Target VCC fields appear in red

A: If the screen shown in Figure 68 appears, this indicates that 
the device has not been properly selected. Repeat Steps 
14-17 from the Flasher downloading procedure.

Figure 68: Incorrect Range and Target VCC Fields     

Q: After selecting Download and Verify, a “Busy does not 
react” error message appears 

A: If the message shown in Figure 69 appears:

•	 Verify that the Flasher5 hardware is properly connected 
to the unit controller.

•	 Verify the programming jumper is in the “PRG” position 
(Figure 26). 

•	 Apply power to the unit controller and perform the 
download again.

Figure 69: Download Error Message      

Q: After selecting Download and Verify, a “supply voltage 
too low” error message appears 

A: If the message shown in Figure 70 appears, verify that the 
power supply is properly connected to the Flasher tool and 
that the power supply is plugged in to the power source.

Figure 70: Download Error Message      

Q: After selecting Download and Verify, an “ID mismatch” 
error message appears 

A: If the message shown in Figure 71 appears, perform the 
following steps:

1.	 Verify that the passcode has been set correctly in Step 
21 from the Flasher Download Procedure.

2.	 Remove power from the unit controller.

3.	 Apply power to the unit controller.

4.	 Repeat the Flasher download procedure.

NOTE:	 Replace the unit controller if this problem persists 
after repeating the programming process.

http://www.DaikinApplied.com


Troubleshooting Guide and FAQ

www.DaikinApplied.com	 39	 OM 1085-8 • MICROTECH III CONTROLLER

Figure 71: Download Error Message     

Segger J-Link/J-Flash ARM 
The following section summarizes common issues with J-Link 
tools and the corresponding solutions.

Q: “Failed to connect” error message appears
A: If the message shown in Figure 72 appears, follow these 

steps:

1.	 Verify that the unit controller has power. 

2.	 Select Auto from the J-Flash Target tab. 

3.	 Click Yes if the message shown in Figure 73 appears.

4.	 If the message shown in Figure 74 appears, the BACnet 
communication module flash memory must be manually 
erased by continuing to Step 5 below. If this message 
does not appear, proceed to the Download BACnet 
Communication Module Software section.

5.	 Remove the jumper from pin 4 and pin 5 on J2 of the 
BACnet communication module, if connected (Figure 
75).

6.	 With power applied to the unit controller, connect the 
jumper between pin 5 and pin 6 on J2 of the BACnet 
communication module as shown in Figure 33.

7.	 Remove power from the unit controller.

8.	 Remove the jumper from pin 5 and 6 on J2 of the 
BACnet communication module, replacing the jumper on 
pin 4 and pin 5 of the BACnet communication module, if 
previously connected.

9.	 Apply power to the unit controller. The flash memory has 
now been completely erased, so all configured settings 
return to default values.

10.	 Proceed to the Download BACnet Communication 
Module Software section. 

Figure 72: Failed to Connect Error Message      

Figure 73: Relocate Message      

Figure 74: Locked Program Error Message      

Figure 75: Manual Erase Jumpers      
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Daikin Applied Training and Development
Now that you have made an investment in modern, efficient Daikin equipment, its care should be a high 
priority. For training information on all Daikin HVAC products, please visit us at www.DaikinApplied.com 
and click on Training, or call 540-248-9646 and ask for the Training Department.

Warranty

All Daikin equipment is sold pursuant to its standard terms and conditions of sale, including Limited 
Product Warranty. Consult your local Daikin Applied Representative for warranty details. To find your 
local Daikin Applied Representative, go to www.DaikinApplied.com.

Aftermarket Services

To find your local parts office, visit www.DaikinApplied.com or call 800-37PARTS (800-377-2787).  
To find your local service office, visit www.DaikinApplied.com or call 800-432-1342.

This document contains the most current product information as of this printing. For the most up-to-date 
product information, please go to www.DaikinApplied.com.

Products manufactured in an ISO Certified Facility.
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